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This	help	file	describes	the	NI-CAN	software	features	within	National
Instruments	Measurement	&	Automation	Explorer	(MAX).	The	NI-CAN
features	within	MAX	enable	you	to:

Verify	the	installation	of	your	NI	CAN	and	LIN	hardware
Configure	software	properties	for	each	port
Create	or	import	configuration	information	for	the	Channel	API
Interact	with	your	CAN	or	LIN	network	using	various	tools
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To	comment	on	National	Instruments	documentation,	refer	to	the	National
Instruments	Web	site.
©	2002–2007	National	Instruments	Corporation.	All	rights	reserved.

javascript:WWW(WWW_Feedback)


Conventions
This	help	file	uses	the	following	conventions:
<	> Angle	brackets	that	contain	numbers	separated	by	an	ellipsis	represent	a	range	of	values

associated	with	a	bit	or	signal	name—for	example,	DBIO<3..0>.

[	] Square	brackets	enclose	optional	items—for	example,	[response].

» The	»	symbol	leads	you	through	nested	menu	items	and	dialog	box	options	to	a	final
action.	The	sequence	File»Page	Setup»Options	directs	you	to	pull	down	the	File	menu,
select	the	Page	Setup	item,	and	select	Options	from	the	last	dialog	box.
This	icon	denotes	a	tip,	which	alerts	you	to	advisory	information.

This	icon	denotes	a	note,	which	alerts	you	to	important	information.

bold Bold	text	denotes	items	that	you	must	select	or	click	on	in	the	software,	such	as	menu
items	and	dialog	box	options.	Bold	text	also	denotes	parameter	names,	emphasis,	or	an
introduction	to	a	key	concept.

green Underlined	text	in	this	color	denotes	a	link	to	a	help	topic,	help	file,	or	Web	address.

italic Italic	text	denotes	variables	or	cross	references.	This	font	also	denotes	text	that	is	a
placeholder	for	a	word	or	value	that	you	must	supply.

monospace Text	in	this	font	denotes	text	or	characters	that	you	should	enter	from	the	keyboard,
sections	of	code,	programming	examples,	and	syntax	examples.	This	font	is	also	used	for
the	proper	names	of	disk	drives,	paths,	directories,	programs,	subprograms,	subroutines,
device	names,	functions,	operations,	variables,	filenames	and	extensions,	and	code
excerpts.



CAN	and	LIN	Overview
This	topic	provides	an	overview	of	CAN	and	LIN	concepts.



CAN	Overview
In	the	past	few	decades,	the	need	for	improvements	in	automotive
technology	has	led	to	increased	use	of	electronic	control	systems	for
functions	such	as	engine	timing,	anti-lock	brake	systems,	and
distributorless	ignition.	With	conventional	wiring,	data	is	exchanged	in
these	systems	using	dedicated	signal	lines.	As	the	complexity	and
number	of	devices	has	increased,	using	dedicated	signal	lines	has
become	increasingly	difficult	and	expensive.	To	overcome	the	limitations
of	conventional	automotive	wiring,	Bosch	developed	the	Controller	Area
Network	(CAN)	in	the	mid-1980s.	Using	CAN,	devices	(controllers,
sensors,	and	actuators)	are	connected	on	a	common	serial	bus.
As	CAN	implementations	increased	in	the	automotive	industry,	CAN	was
standardized	internationally	as	ISO	11898.
CAN	Data	Frame
The	data	frame	is	the	fundamental	unit	of	data	transfer	on	a	CAN
network.	The	following	figure	shows	a	simplified	view	of	the	CAN	data
frame.

When	multiple	CAN	devices	transmit	a	frame	at	the	same	time,	the
identifier	(ID)	resolves	the	collision.	The	highest	priority	ID	continues,	and
the	lower	priority	IDs	retry	immediately	afterward.	The	ISO	11898	CAN
standard	specifies	two	ID	formats:	the	standard	format	of	11	bits	and	the
extended	format	of	29	bits.
The	ID	is	followed	by	a	data	length	code	that	specifies	the	number	of
data	bytes	in	the	frame.	The	length	ranges	from	0	to	8	data	bytes.	The	ID
value	determines	the	meaning	of	the	data	bytes.
CAN	Remote	Frame
In	addition	to	the	data	frame,	the	CAN	standard	specifies	the	remote
frame.	The	remote	frame	includes	the	ID,	but	no	data	bytes.	A	CAN
device	transmits	the	remote	frame	to	request	that	another	device	transmit
the	associated	data	frame	for	the	ID.	In	other	words,	the	remote	frame
provides	a	mechanism	to	poll	for	data.



The	preceding	information	provides	a	simplified	description	of	CAN
frames.	The	CAN	frame	format	includes	many	other	fields,	such	as	error
checking	and	acknowledgement.	For	more	detailed	information	on	the
ISO	11898	CAN	standard,	refer	to	Summary	of	the	CAN	Standard	in	the
NI-CAN	Help.



LIN	Overview
The	LIN	network	uses	a	Master/Slave	approach,	comprised	of	a	LIN
Master	and	one	or	more	LIN	Slaves.	The	following	figure	shows	the	LIN
message	frame.

LIN	Message	Frame
The	message	header	consists	of	a	break	used	to	identify	the	start	of	the
frame,	the	sync	field	used	by	the	slave	node	for	clock	synchronization,
and	an	identifier.	The	identifier	(ID)	consists	of	a	6-bit	message	ID	and	a
2-bit	parity	field.	The	ID	denotes	a	specific	message	address,	but	not	the
destination.	Upon	reception	and	interpretation	of	the	ID	one	slave	will
begin	the	message	response.	The	message	response	consists	of	1-8
data	bytes	of	data	and	an	8-bit	checksum.
The	sequencing	of	message	frames	is	controlled	by	the	master	and	is
fixed	in	a	schedule.	The	schedule	may	be	changed	as	needed.
The	proceeding	information	provides	a	simplified	description	of	the	LIN
message	frame.	For	more	details	on	the	LIN	message	frame	and	on	the
LIN	specification,	refer	to	Summary	of	the	LIN	Standard	in	the	NI-CAN
Help.



NI-CAN	Software	Overview
The	NI-CAN	software	provides	full-featured	Application	Programming
Interfaces	(APIs),	plus	tools	for	configuration	and	analysis	within	National
Instruments	Measurement	&	Automation	Explorer	(MAX).	You	can	use
the	NI-CAN	APIs	to	develop	applications	that	are	customized	to	your	test
and	simulation	requirements	for	your	CAN	and	LIN	hardware.
Frame	API	for	CAN	and	LIN
The	frame	is	the	fundamental	unit	of	data	transfer	on	a	CAN	or	LIN
network.	The	NI-CAN	Frame	API	provides	a	set	of	functions	to	write	and
read	CAN	or	LIN	frames.	Within	the	Frame	API,	the	data	bytes	of	each
frame	are	not	interpreted,	but	are	transferred	in	their	raw	format.	For
example,	you	can	transmit	a	CAN	data	frame	by	calling	a	write	function
with	the	ID,	length,	and	array	of	data	bytes.	For	more	information,	refer	to
the	NI-CAN	Help	at	Help»Help	Topics»NI-CAN»Hardware	and
Software	Manual.
Channel	API	for	CAN
A	typical	CAN	data	frame	contains	multiple	values	encoded	as	raw	fields.
The	following	figure	shows	an	example	set	of	fields	for	a	6-byte	data
frame.



Bytes	1	to	2	contain	a	CruiseCtrlSetSpeed	field	that	represents	a
vehicle	speed	in	kilometers	per	hour	(km/h).	Most	CAN	devices	do	not
transmit	values	as	floating-point	units	such	as	115.6	km/h.	Therefore,	this
field	consists	of	a	16-bit	unsigned	integer	in	which	each	increment
represents	0.0039	km/h.	For	example,	if	the	field	contains	the	value
25000,	that	represents	(25000	*	0.0039)	=	97.5	km/h.
Bytes	3	to	4	contain	another	unsigned	integer	Vehicle	Speed	that
represents	speed	in	km/h.	Bytes	0	and	5	contain	various	Boolean	fields
for	which	1	indicates	"on"	and	0	indicates	"off."
When	you	use	the	NI-CAN	Frame	API	to	read	CAN	data	frames,	you
must	write	code	in	your	application	to	convert	each	raw	field	to	physical
units	such	as	km/h.	The	NI-CAN	Channel	API	enables	you	to	specify	this
conversion	information	at	configuration	time	instead	of	within	your
application.	This	configuration	information	can	be	imported	from	Vector
CANdb	files,	or	specified	directly	in	MAX.
For	each	ID	you	read	or	write	on	the	CAN	network,	you	specify	a	number
of	fields.	For	each	field,	you	specify	its	location	in	the	frame,	size	in	bits,



and	a	formula	to	convert	to/from	floating-point	units.	In	other	words,	you
specify	the	meaning	of	various	fields	in	each	CAN	data	frame.	In	NI-CAN
terminology,	a	data	frame	for	which	the	individual	fields	are	described	is
called	a	message.
In	other	National	Instruments	software	products	such	as	NI-DAQ	and
FieldPoint,	an	application	reads	or	writes	a	floating-point	value	using	a
channel,	which	is	typically	converted	to/from	a	raw	value	in	the
measurement	hardware.	The	NI-CAN	Channel	API	also	uses	the	term
channel	to	refer	to	floating-point	values	converted	to/from	raw	fields	in
messages.	In	CAN	products	of	other	vendors,	this	concept	is	often
referred	to	as	a	signal.	When	a	CAN	message	is	received,	NI-CAN
converts	the	raw	fields	into	physical	units,	which	you	then	obtain	using
the	Channel	API	read	function.	When	you	call	the	Channel	API	write
function,	you	provide	floating-point	values	in	physical	units,	which	NI-
CAN	converts	into	raw	fields	and	transmits	as	a	CAN	message.
For	more	information,	refer	to	the	NI-CAN	Help	at	Help»Help	Topics»NI-
CAN»Hardware	and	Software	Manual.



CAN	and	LIN	Hardware
Windows	System
National	Instruments	hardware	for	CAN	is	used	by	both	NI-CAN	and	NI-
DNET	(DeviceNet)	software.	National	Instruments	hardware	for	LIN	is
used	only	by	NI-CAN	software.
CAN	and	LIN	hardware	is	displayed	under	Devices	and	Interfaces	in
MAX.	All	NI	hardware	is	installed	automatically	and	displayed	when	MAX
refreshes	its	configuration.	You	can	refresh	MAX	by	pressing	<F5>.
Windows	automatically	assigns	the	resources	(interrupt	number	and
memory	range)	for	the	hardware.



Testing	CAN	and	LIN	Hardware
To	verify	installation	of	your	CAN	or	LIN	hardware,	right-click	on	the	CAN
or	LIN	interface,	then	select	Self-test	in	MAX.	If	the	self	test	passes,	the
hardware	icon	shows	a	checkmark.	If	the	self	test	fails,	the	hardware	icon
shows	a	?	mark,	and	the	Test	Status	in	the	right	pane	describes	the
problem.
It	is	also	possible	to	test	all	CAN	and	LIN	hardware	in	the	system	at	once
by	selecting	Tools»»NI-CAN»Test	All	Local	Cards	in	the	main	menu.



Troubleshooting	Self	Test	Failures
The	following	sections	explain	common	error	messages	generated	by	the
Self-test.
Application	In	Use
This	error	occurs	if	you	are	running	an	application	that	is	using	the	CAN
or	LIN	hardware.	The	self	test	aborts	to	avoid	adversely	affecting	your
application.	Before	running	the	self	test,	exit	all	applications	that	use	NI-
CAN	or	NI-DNET.	If	you	are	using	LabVIEW,	you	may	need	to	exit
LabVIEW	to	unload	the	NI-CAN	driver.
Memory	Resource	Conflict
This	error	occurs	if	the	memory	resource	assigned	to	a	CAN	or	LIN	card
conflicts	with	the	memory	resources	being	used	by	other	devices	in	the
system.	Resource	conflicts	typically	occur	when	your	system	contains
legacy	boards	that	use	resources	not	properly	reserved	with	the	Device
Manager.	If	a	resource	conflict	exists,	write	down	the	memory	resource
that	caused	the	conflict	and	refer	to	the	documentation	for	your	Windows
operating	system	for	instructions	on	how	to	use	the	Device	Manager	to
reserve	memory	resources	for	legacy	boards.	After	the	conflict	has	been
resolved,	run	the	Self	Test	again.
Interrupt	Resource	Conflict
This	error	occurs	if	the	interrupt	resource	assigned	to	a	CAN	or	LIN	card
conflicts	with	the	interrupt	resources	being	used	by	other	devices	in	the
system.	Resource	conflicts	typically	occur	when	your	system	contains
legacy	boards	that	use	resources	not	properly	reserved	with	the	Device
Manager.	If	a	resource	conflict	exists,	write	down	the	interrupt	resource
that	caused	the	conflict	and	refer	to	the	documentation	for	your	Windows
operating	system	for	instructions	on	how	to	use	the	Device	Manager	to
reserve	interrupt	resources	for	legacy	boards.	After	the	conflict	has	been
resolved,	run	the	Self	Test	again.
NI-CAN	Software	Problem	Encountered
This	error	occurs	if	the	Self	Test	detects	that	it	is	unable	to	communicate
correctly	with	the	CAN	or	LIN	hardware	using	the	installed	NI-CAN	or	NI-
DNET	software.	If	you	get	this	error,	shut	down	your	computer,	restart	it,



and	run	the	Self	Test	again.
If	the	error	continues	after	restart,	uninstall	NI-CAN	and	NI-DNET,	and
then	reinstall.
NI-CAN	Hardware	Problem	Encountered
This	error	occurs	if	the	Self	Test	detects	a	defect	in	the	CAN	or	LIN
hardware.	If	you	get	this	error,	write	down	the	numeric	code	shown	with
the	error,	and	contact	National	Instruments.



Configuring	CAN	and	LIN	Ports
The	physical	ports	of	the	CAN	and	LIN	hardware	are	listed	under	the
hardware's	name.	To	configure	software	properties	for	each	port,	right-
click	on	the	port	and	select	Properties.
For	more	information	on	configuration,	refer	to	Port	Properties	Dialog
Box.
For	more	information	on	changing	the	representation	of	a	CAN	card	in
MAX	between	NI-CAN	and	NI-DNET,	refer	to	Protocol	Dialog	Box.



LabVIEW	Real-Time	(RT)	System
To	test	and	configure	PXI	CAN	cards	on	a	LabVIEW	RT	system,	use	the
RT	Hardware	Configuration	Utility	in	Tools»NI-CAN»RT	Hardware
Configuration.	The	card	and	port	configuration	in	this	utility	is	similar	to
Devices	and	Interfaces	under	Windows.	For	more	information,	refer	to
LabVIEW	RT	Configuration.



LabVIEW	Real-Time	(RT)	Configuration
LabVIEW	RT	combines	easy-to-use	LabVIEW	programming	with	the
power	of	real-time	systems.	When	you	use	a	National	Instruments	PXI
controller	as	a	LabVIEW	RT	system,	you	can	install	a	PXI	CAN	card	and
use	the	NI-CAN	and	NI-DNET	APIs	to	develop	real-time	applications.	For
example,	you	can	simulate	the	behavior	of	a	control	algorithm	within	a
CAN	device,	using	data	from	received	CAN	messages	to	generate
outgoing	CAN	messages	with	deterministic	response	times.



Installation
As	with	any	other	NI	product	for	LabVIEW	RT,	you	download	the	NI-CAN
and	NI-DNET	software	to	your	LabVIEW	RT	system	using	the	Remote
Systems	branch	in	MAX.	For	more	information,	refer	to	the	LabVIEW	RT
documentation.



Hardware	Configuration
After	you	have	installed	your	PXI	CAN	cards	and	downloaded	the	NI-
CAN	software	to	your	LabVIEW	RT	system,	you	need	to	verify	the
installation	and	assign	interface	names	to	CAN	ports.	In	the	MAX	Tools
menu,	select	NI-CAN»RT	Hardware	Configuration.
The	RT	Hardware	Configuration	tool	begins	with	a	dialog	that	requests
your	PXI	system	IP	address.	Enter	the	IP	address	from	your	original
Remote	Systems	configuration,	which	is	the	same	IP	address	that	you
use	within	LabVIEW.	After	a	connection	has	been	established
successfully,	subsequent	execution	of	the	NI-CAN	RT	Hardware
Configuration	tool	uses	the	same	IP	address.	If	you	need	to	change	the
IP	address	to	a	different	PXI	system,	select	Server	Address	from	the
Network	menu.
Within	the	RT	Hardware	Configuration	tool,	if	you	do	not	see	the	installed
PXI	CAN	cards,	select	Refresh	from	the	View	menu.	To	perform	a	self-
test	for	all	PXI	CAN	cards,	select	Test	All	from	the	Test	menu.	The	status
for	each	card's	self-test	is	displayed	in	the	same	manner	as	the	MAX
Devices	and	Interfaces	branch	on	your	local	Windows	system.
To	assign	an	interface	name	to	each	CAN	port,	right-click	the	port	and
select	Properties.	The	resulting	properties	dialog	is	the	same	as	the	Port
Properties	Dialog	Box	on	your	local	Windows	system.



Using	NI-CAN	Channels
To	use	the	NI-CAN	Channel	API	on	your	LabVIEW	RT	system,	you	must
download	channel	configuration	information.	Within	the	Data
Neighborhood	branch	in	MAX,	right-click	on	CAN	Channels	and	select
Send	to	RT	System.
What	to	Send
By	default,	the	current	channel	configuration	in	MAX	is	sent	to	the	RT
system.	If	necessary,	you	can	also	send	channel	configurations	that	you
previously	saved	to	a	file.
Where	to	Send
The	configuration	is	sent	using	an	FTP	connection	to	the	RT	system.	The
IP	address	(or	machine	name)	is	required	for	the	connection.	Enter	the	IP
address	from	your	original	Remote	Systems	configuration,	which	is	the
same	IP	address	that	you	use	within	LabVIEW.
If	your	PXI	system	is	configured	for	password	protection,	you	must
provide	the	FTP	user	and	password.	If	no	password	protection	is
configured,	you	can	leave	the	FTP	user	and	password	blank.
There	is	no	destination	file	required	for	the	configuration.	Within	your
LabVIEW	RT	application,	you	can	access	the	channels	without	using	a
file	prefix	for	the	Channel	API	Get	Names	function	or	Initialize	function.



Port	Properties	Dialog	Box
Use	this	dialog	box	to	configure	the	interface	and	the	baud	rate	for	a	port.



Interface
In	the	Properties	dialog,	you	assign	an	interface	name	to	the	port,	such
as	CAN0	or	CAN1.	The	interface	name	identifies	the	physical	port	within
NI-CAN	APIs.	The	Properties	dialog	also	contains	the	default	baud	rate
for	MAX	tools	and	the	Channel	API.
Interfaces	previously	assigned	to	other	physical	ports	are	marked	with	an
asterisk	in	the	list	box.	If	you	select	an	interface	used	by	another	port,	the
other	port	is	reassigned	to	the	first	unused	interface.



Baud	Rate
The	baud	rate	in	this	dialog	is	the	default	value	for	applications	that	use
the	Channel	API	and	for	the	MAX	tools.	You	can	also	use	the	Channel
API	Set	Property	function	to	set	the	baud	rate	within	your	application.
Applications	with	CAN	that	use	the	Frame	API	must	set	the	baud	rate
using	the	ncConfig	function.	Applications	with	LIN	that	use	the	Frame
API	must	set	the	baud	rate	using	the	ncSetAttribute	function.
Use	the	Baud	Rate	drop	box	to	select	from	a	list	of	commonly	used	baud
rates.
By	selecting	the	Advanced	button	for	CAN	hardware,	you	have	full
control	over	the	bit	timing	registers.	There	are	two	8-bit	registers,	BTR0
and	BTR1.	The	calculations	for	the	bit	timing	registers	use	a	clock	of	8
MHz	for	the	Baud	Rate	Prescaler	(BRP).	The	user	can	use	one	of	the
following	methods	to	set	the	registers:

Edit	Bit	Timing	Register	Value	(BTR0,	BTR1)
This	method	is	recommended	when	you	know	the	required	register
values.

Edit	Segments	of	Bit	Timing	Register
This	method	is	recommended	when	you	want	to	change	a	particular
field	in	the	registers.

Baud	Rate...
This	button	opens	a	window	to	view	the	register	values	(BTR0	and
BTR1)	for	a	given	baud	rate.
The	baud	rate	is	corrected	to	the	nearest	possible	value.	For	example,
85	kBaud	will	be	changed	to	84.211	kBaud.	The	values	for	SJW	and
SPL	do	not	affect	the	baud	rate.	After	creating	a	list,	you	can	pick	one
of	the	values	and	select	Use	to	use	those	BTR	values	as	your	baud
rate	setting.

By	selecting	the	Advanced	button	for	LIN	hardware,	you	can	enter	any
value	from	2400	to	20000	baud.	For	information	on	the	actual	baud	rate
calculated,	refer	to	the	ncSetAttribute	function	within	the	Frame	API
section	of	your	NI-CAN	Hardware	and	Software	Manual.



Transceiver
This	selection	is	available	only	for	XS	CAN	cards.	National	Instruments
XS	CAN	cards	contain	multiple	transceivers	for	each	CAN	interface,	and
the	transceiver	is	selected	by	software.	For	more	information	on	XS	CAN
cards,	refer	to	the	NI-CAN	Help	at	Help»Help	Topics»NI-
CAN»Hardware	and	Software	Manual.
The	transceiver	type	in	this	selection	is	the	default	value	for	applications
that	use	the	Frame	API	or	Channel	API.	This	transceiver	type	is	switched
into	use	when	your	application	opens	or	initializes	the	specified	interface.
You	can	also	change	the	transceiver	type	within	your	application,	using
Set	Attribute	in	the	Frame	API	and	Set	Property	in	the	Channel	API.



FP-1300	Config
FieldPoint	1300	is	the	National	Instruments	modular	I/O	product	for	CAN.
If	you	have	installed	the	software	for	the	FP-1300	product,	the
configuration	tool	appears	in	the	CAN	port	right-click	menu.	To	start	the
FP-1300	Config	tool,	right-click	on	a	CAN	port	and	select	FP-1300
Config.
To	open	help	for	the	FP-1300	Config	tool,	click	on	Help	in	the	tool's	main
menu.



Bus	Monitor
The	Bus	Monitor	is	a	tool	for	monitoring	data	transfer	on	a	particular	CAN
or	LIN	bus.	To	start	the	Bus	Monitor,	right-click	on	a	CAN	or	LIN	port	(a
sub-item	of	a	card	under	Devices	and	Interfaces)	and	select	Bus
Monitor.
The	Bus	Monitor	offers	several	functions,	including:

Listing	of	bus	traffic
Display	of	all	data	bytes	of	all	transmitted	frames	on	the	bus
Statistics	about	the	appearance	of	all	frames
Logging	of	all	or	single	frames



Main	Window
Tip		The	main	window	can	be	resized	by	grabbing	and	dragging	the	right	bottom	corner	of	the
window,	or	even	maximized	to	occupy	the	full	screen.

MAX	Port	Settings
Interface	and	Baud	Rate	display	values	assigned	in	MAX	to	the	port.
You	cannot	change	them	in	the	Bus	Monitor.	To	change	the	values,	exit
the	Bus	Monitor,	right-click	on	a	port	in	MAX,	and	select	Port	Properties.
After	changing	the	values,	restart	the	Bus	Monitor.
Update	Rate
Update	Rate	is	the	rate	at	which	the	Bus	Monitor	updates	(in
milliseconds).
Bus	Load
Bus	Load	is	a	calculation	of	the	amount	of	bus	traffic	measured	on	the
selected	interface.	The	calculation	is	shown	as	a	percentage	(%)	ranging
from	0	to	100%.	The	only	frame	types	included	in	the	calculation	are	data
and	remote.
This	feature	is	only	for	available	for	CAN	hardware.
Listen	Only
This	checkbox	is	available	for	CAN	Series	2,	847x	CAN,	and	847x	with
Sync	CAN	hardware.	When	checked,	the	interface	receives	frames	in	a
passive	manner	and	does	not	transmit	acknowledgements.
CRC	Type
This	selection	allows	you	to	use	Classic	or	Enhanced	CRC	(Checksum)
type.	This	attribute	applies	only	to	the	USB-8476	and	USB-8476s	LIN
hardware.
Start	and	Stop	Button
The	button	shows	Stop	when	the	monitoring	is	running.	You	can	press	it
to	stop	receiving	and	displaying	frames	in	the	list.	The	button	shows	Start
when	the	monitoring	is	not	running.	When	the	Bus	Monitor	is	launched
from	MAX,	it	starts	in	running	mode.
List	of	Received	Messages



The	list	contains	the	following	information:
Arb.	ID:	For	CAN,	the	Arbitration	ID	(standard	11-bit	or	29-bit	ID)	of
the	CAN	frame.	Remote	frames	are	denoted	with	an	R.	Extended
frames	(29-bit	ID)	are	denoted	with	an	*.	For	LIN,	this	field	contains
the	6-bit	ID	of	the	LIN	frame.
Length:	Number	of	bytes	in	the	frame
Data:	Data	bytes	contained	in	the	frame
Time	Stamp:	The	timestamp	of	the	most	recent	frame
Rate:	Transmission	rate	of	the	frame	(in	Hertz)
dt	Min:	Minimum	delta	time	between	two	frames	of	the	particular
Arbitration	ID
dt	Max:	Maximum	delta	time	between	two	frames	of	the	particular
Arbitration	ID
#	(total):	Number	of	transmitted	frames	since	start
Note		You	can	set	the	resolution	of	the	timestamps	and	dt	Min	and	dt	Max	to	either	seconds	or
milliseconds	in	the	Options	dialog.

ID	Logger	Window
If	you	double	click	on	a	specific	row	of	a	message	ID,	an	additional
window	called	ID	Logger	pops	up.
The	ID	Logger	window	logs	all	messages	related	to	the	selected	ID.
Displayed	are	the	time	information	(when	the	message	was	received	on
the	CAN	or	LIN	port)	and	the	message	data.

Bus	Statistics	Button



This	button	opens	another	dialog	box	which	displays	current	bus
operation	information.	For	CAN	hardware	the	following	statistics	are
displayed:

Std.Data:	Data	frames	with	an	11-bit	Arbitration	ID
Ext	Data:	Data	frames	with	a	29-bit	Arbitration	ID
Remote:	Remote	frames
Error	Frames:	Error	frames
Fr/s:	Frames	per	second
Total:	Number	of	received	frames	since	Bus	Monitor	was	started

For	LIN	hardware	the	following	statistics	are	displayed:
Full	Frames:	Full	frames
Bus	Inactive:	Bus	inactive	frames
Error	Frames:	Error	frames
Fr/s:	Frames	per	second
Total:	Number	of	received	frames	since	the	Bus	Monitor	was
started



Error	Details
The	error	code	indicates	the	current	status	of	NI-CAN	function	calls.	Click
on	Error	Details	to	see	an	explanation	of	the	error	code.
Options
This	button	is	disabled	when	the	Bus	Monitor	is	running.	To	change	the
options,	press	the	Stop	button.



Options	Window
Attributes
Attributes	changes	the	display	options	for	messages	in	the	list	and	in	the
Disk	Streaming	file.

Arb	ID
You	can	display	the	Arbitration	ID	of	a	frame	in	decimal	or	hexadecimal
format.

Time	Stamp
You	can	display	the	time	stamping	of	the	received	frames	either	in
seconds	since	the	start	of	the	scan	or	Time	of	Day	in	the	format
hh:mm:ss.

Dist	Min/Max
This	selection	allows	you	to	display	dt	Min	and	dt	Max	either	in
seconds	or	milliseconds.

Error	Frame	Detection
This	selection	specifies	whether	to	log	bus	errors	when	the	interface
detects	a	bus	error.	Error	frame	detection	is	not	supported	by	Series	1
hardware.	For	more	information	on	error	frame	detection	for	CAN	and
LIN	interfaces	refer	to	the	documentation	on	the	Log	Bus	Errors?
attribute	in	your	NI-CAN	Hardware	and	Software	Manual.

Stream	to	Disk
This	selection	activates	the	disk	streaming	feature.	You	can	use	Stream
to	Disk	to	write	frames	to	a	file.	Stream	to	Disk	stores	all	received
frames	or	frames	with	a	particular	ID	to	a	file.
File	Name...
File	Name...	specifies	the	filename	and	the	file	target	directory.	The
filename	can	have	either	a	.CSV	(comma-separated	value),	or	a	.NCL
(NI-CAN	logfile),	extension.	The	.CSV	extension	saves	the	logged	data	in
ASCII	format.	Typically,	.CSV	files	are	used	with	Microsoft	programs	like
MS	Excel.	The	.NCL	extension	saves	the	logged	data	in	binary	format.
For	more	information	on	the	.NCL	extension,	refer	to	the	NI-CAN	Logfile
specification.	The	default	file	extension	is	.CSV.



Note		When	logging	to	a	.NCL	file,	the	start	trigger	frame	is	always	logged.	Refer	to	the	NI-
CAN	Hardware	and	Software	Manual	for	details	on	the	start	trigger	frame	format.

For	Multi	Files	(see	below),	this	specifies	the	filename	root.	All	files
share	the	same	name	root;	the	remaining	filename	characters	(up	to	four)
are	replaced	by	numbers	that	increment	by	one	from	file	to	file.
Disk	Streaming
This	option	allows	you	to	chose	to	Stream	All	Frames	to	the	file	or	to
Stream	Single	Frame	with	a	specified	arbitration	ID.
Separator
You	can	select	tab,	semicolon,	or	comma	as	the	ASCII	field	delimiter.
Multi	File
Use	this	option	to	write	data	to	a	series	of	separate	files.
Check	the	Multi	File	option	first	to	enable	the	other	options
The	advantage	of	using	the	Multi	File	option	is	that	the	history	of	a	long
run	can	be	retrieved	and	the	concern	of	having	data	overwritten	is
eliminated.
Chain	Filename	Series
If	you	select	this	option,	the	program	searches	the	filename	list	in	the
specified	directory	for	the	file	with	the	highest	number.	The	first	file
number	in	the	new	series	is	the	next	number	after	the	highest	number	in
the	preceding	series.
The	module	checks	the	chosen	directory's	contents	when	the	scan	starts
and	generates	a	new	file	right	after	the	oldest	existing	file.	Older	files	are
not	overwritten.
If	you	do	not	select	this	option,	the	file	numbering	restarts	when	you
generate	new	files.	Existing	files	are	overwritten.
Filename	Numbering
You	can	specify	the	number	of	digits	to	append	to	the	filename.	The	limit
is	four	digits.

Note		Because	the	four-digit	selection	can	possibly	create	up	to	10,000	files,	we	recommend
using	digits	1	to	3.

File	Numbers



You	can	enter	the	following	items	to	name	the	file	and	begin	the	disk
streaming	procedure:

First	File	No
This	entry	determines	the	first	number	assigned	in	the	file	list.	The
value	allowed	here	depends	on	the	number	of	digits	specified	in
Filename	Numbering:	0,	00,	000,	or	0000.

Last	File	No
This	entry	determines	the	last	number	assigned	in	the	file	list.	The
value	allowed	here	depends	on	the	number	of	digits	specified	in
Filename	Numbering:	9,	99,	999,	or	9999.

Stop	after	Last	File
If	you	set	this	option,	disk	streaming	stops	after	the	file	with	the	last	file
number	is	written.

Restart	after	Last	File
Use	this	option	to	stream	to	file	in	a	cyclical	fashion.	If	you	check	this
box	and	the	last	possible	file	is	written,	the	list	starts	again	with	file
number	0.	The	value	allowed	here	depends	on	the	number	of	digits
specified	in	Filename	Numbering:	9,	99,	999,	or	9999.

File	Switch	Condition
This	value	determines	the	amount	of	data	(in	kilobytes)	written	to	each
file.	After	this	amount	of	data	has	been	written	to	one	file,	next	file	is
generated	automatically.



Message	Properties	Dialog	Box
To	create	a	message,	right-click	CAN	Channels	in	Data	Neighborhood
and	select	Create	Message.	Configure	each	property	of	a	message
using	the	information	in	the	sections	below.	For	information	about
changing	properties	for	multiple	messages	at	once,	refer	to	Changing
Properties	of	Multiple	Messages	or	Channels.



Name
The	message	name	can	contain	up	to	64	characters.	The	message
names	must	be	unique	in	MAX.	The	message	name	must	not	contain	a
colon	(:),	period	(.),	or	comma	(,).



Arbitration	ID
The	arbitration	ID	is	the	identifier	for	the	CAN	message.	The	standard
format	contains	11	bits,	the	extended	format	29	bits.	You	can	display	the
arbitration	ID	in	hexadecimal	or	decimal	by	right-clicking	on	CAN
Channels	and	selecting	Options.	In	hexadecimal	mode,	the	display	has
a	0x	prefix,	but	it	is	not	necessary	to	enter	this	prefix	before	the	ID.



J1939
The	J1939	button	is	only	enabled	when	selecting	Extended	Frame
Format.	MAX	provides	a	dialog	for	editing	Extended	CAN	IDs	conforming
to	the	J1939	standard.



Data	Bytes
Number	of	data	bytes	in	the	message.	A	message	can	contain	1	to	8	data
bytes.



Interface
Default	interface	to	be	used	for	this	message.	If	the	interface	is	not
provided	to	the	Channel	API	Initialize	function,	this	default	interface	is
used.	If	the	interface	is	ANY	in	MAX,	it	implies	that	no	interface	has	been
assigned	and	an	interface	must	be	provided	to	the	Initialize	function.



Message	Channels
The	message	channel	list	contains	the	names	of	all	channels	associated
with	this	message.	You	can	add	a	channel	to	the	message	by	clicking	the
Add	button	or	change	the	properties	of	an	existing	channel	by	clicking
the	Edit	button.

Note		When	you	are	creating	a	message	using	the	Create	Message	menu	selection,	you
cannot	add	channels	to	the	message	using	the	Add	button,	as	the	message	does	not	exist	yet.
After	the	message	is	created,	you	can	add	channels	by	right-clicking	on	the	message,	selecting
Properties,	and	using	the	Add	option	to	add	the	desired	channels.



Message	Overview
The	message	overview	window	displays	the	message	with	all	contained
channels	graphically.	The	vertical	axis	describes	the	byte	number,
starting	with	0	for	the	first	byte.	The	horizontal	axis	describes	the	bit
number	of	the	byte	starting	with	0	for	the	least	significant	bit	in	the	byte.
Bytes	not	available	in	the	message	are	dimmed.
A	channel	can	start	in	any	valid	bit	of	the	message.	The	channel	bits	are
numbered	beginning	with	0	for	the	least	significant	bit.
The	channels	are	shown	in	the	Message	Overview	using	alternating
colors.
Clicking	on	any	bit	in	a	channel	highlights	the	channel	and	selects	the
channel	name	in	the	list	box.	Clicking	again	outside	of	any	channel
returns	to	the	alternating	colors	view.
Overlapping	bits	of	two	channels	are	highlighted	by	red	crosses.	A	red
indicator	above	the	message	overview	indicates	an	error	condition.	An
error	also	occurs	when	the	channel	bits	exceed	the	64-bit	range	of	a
message.	In	such	an	event,	the	bits	are	not	displayed,	but	you	can
recognize	the	error	condition	by	the	red	indicator.



Comment
Contains	any	comment	for	documentation	purposes.	The	maximum	size
of	the	comment	is	1024	characters.



SAE	J1939	Arbitration	ID
J1939	is	a	high-speed,	Class	C	type	communications	network	designed
to	support	real-time	closed	loop	control	functions	between	electronic
control	devices,	which	may	be	physically	distributed	throughout	the
vehicle.
The	J1939	protocol	typically	uses	the	29-bit	or	the	extended	format	for
the	arbitration	IDs.	As	shown	in	the	following	figure,	the	arbitration	ID
comprises	of	the	Priority	(first	3	bits),	Parameter	Group	Number	(PGN)
(18	bits),	and	the	Source	Address	(8	bits).

29	Bit	Arbitration	ID
Most	messages	on	J1939	are	intended	to	be	broadcast.	This	means	the
data	is	transmitted	on	the	network	without	directing	it	to	a	specific
destination.	This	permits	any	device	to	use	the	data	without	requiring
additional	request	messages.	However,	by	modifying	the	PGN,	you	can
direct	messages	to	a	specific	address	(destination	address).	As	shown	in
the	following	figure,	the	PGN	comprises	of	a	reserved	bit	(first	bit),	data
page	(1	bit	field),	PDU	(Protocol	Data	Unit)	format	(8	bit	fields),	and	the
PDU	specific	field	(8	bit	fields).	PDU	specific	fields	can	either	represent	a
group	extension	or	a	specific	destination	address	depending	on	the	value
of	the	PDU	format	fields.	For	example,	for	PDU	formats	between	240	and
255,	the	PDU	specific	field	denotes	a	group	extension.	For	PDU	formats
less	than	240,	the	PDU	specific	field	denotes	a	destination	address.

Parameter	Group	Number
For	a	detailed	description	of	the	J1939	terminology,	refer	to	the	SAE
J1939	specifications.



SAE	J1939	Arbitration	ID	Dialog	Box
You	can	invoke	this	dialog	box	from	the	Message	Properties	dialog	box.
It	is	available	only	when	the	Arbitration	ID	mode	is	set	to	Extended.
The	dialog	box	shows	the	arbitration	ID	in	the	format	of	SAE	J1939
higher	layer	protocol.	For	more	information,	refer	to	SAE	J1939
Arbitration	ID.



Priority
You	can	set	Priority	to	a	value	between	0	and	7.	This	field	determines	the
priority	of	the	message	on	the	bus.	You	can	set	the	priority	of	any
message	from	highest	(0)	to	lowest	(7).



Source	Address
An	8-bit	field	that	contains	the	identifier	of	the	device	or	source	sending
the	message.	There	should	be	only	one	device	with	a	given	source
address.
You	can	set	Source	Address	to	a	value	between	0	and	255.



Parameter	Group	Number	(PGN)
Represents	one	or	more	parameters	where	a	parameter	is	a	piece	of
data	such	as	Engine	RPM.	The	PGN	identifies	or	labels	commands,	data,
requests,	acknowledgements,	and	negative	acknowledgements.
You	can	edit	the	PGN	in	two	modes	by	selecting	either	Edit	as	Number
or	Edit	as	PGN	Segments.	The	PGN	is	displayed	in	decimal	or
hexadecimal	depending	on	the	setting	for	the	arbitration	ID	in	Options
dialog	box.	When	using	hexadecimal	mode,	The	PGN	is	displayed	with
0x	prefix.	However,	it	is	not	necessary	to	enter	the	prefix	when	entering
the	value.
When	the	Edit	as	PGN	Segments	option	is	selected	to	edit	the	PGN,	the
various	component	fields	are	enabled.
Segments	of	the	PGN	are	always	displayed	and	entered	in	decimal
format.



Reserved	Bit
This	bit	is	currently	reserved	for	future	use	by	the	SAE.	To	comply	with
SAE	J1939,	you	must	set	this	bit	to	zero.



Data	Page
The	data	page	bit	selects	an	auxiliary	page	of	Parameter	Group
descriptions.	Assignment	of	all	PGNs	available	in	page	zero	is	complete
(filled)	before	the	page	one	assignments	are	made.



PDU	Format
This	is	an	8-bit	field	within	the	PGN	that	determines	the	format	of	a
Protocol	Data	Unit	(PDU).	It	determines	whether	the	message	is	a
broadcast	message	or	directed	to	a	specific	address.



PDU	Specific
This	is	an	8-bit	field	within	the	PGN	that	becomes	either	a	Group
Extension	ID	or	a	Destination	address	depending	on	the	value	of	the
PDU	Format.



Resulting	ID
The	ID	is	displayed	in	decimal	or	hexadecimal	format	depending	on	the
setting	in	the	Options	dialog	box.



CAN	Channel	Properties	Dialog	Box
To	create	a	channel,	right-click	on	a	message	in	CAN	Channels	and
select	Create	Channel.	Configure	each	property	for	a	channel	by	using
the	information	in	the	sections	below.	For	information	about	changing
properties	for	multiple	channels	at	once,	refer	to	Changing	Properties	of
Multiple	Messages	or	Channels.



Channel	Name
The	channel	name	can	contain	up	to	64	characters.	The	channel	name
must	be	unique	in	the	message.	The	name	must	not	contain	a	colon	(:),
period	(.),	or	comma	(,).
If	the	channel	name	is	not	unique	in	MAX	(that	is,	at	least	two	messages
contain	a	channel	with	the	same	name),	the	message	name	must	also	be
specified	in	the	channel	string	passed	to	the	Channel	API	Initialize
function.	For	example,	if	two	messages	(Message1	and	Message2)	have
a	channel	with	the	same	name	(ChannelX),	in	the	Channel	API,	the
channel	is	referenced	as	"Message1.ChannelX"	or
"Message2.ChannelX".



Start	Bit
Start	Bit	specifies	the	location	of	the	least	significant	bit	(bit	0)	of	the
channel.	The	number	starts	at	the	least	significant	bit	of	the	first	byte.	The
maximum	bit	number	allowed	in	a	message	containing	n	bytes	is	(8*n)-1.



No.	of	Bits
No.	of	Bits	is	the	number	of	bits	used	for	this	channel.



Byte	Order
Byte	Order	defines	how	the	bytes	of	the	channel	are	placed	in	the
message.
As	shown	in	the	following	figure,	Motorola	format	stores	the	high-order
byte	at	the	starting	address,	while	the	Intel	format	stores	the	low-order
byte	at	the	starting	address.	The	low-order	byte	contains	the	bits	for	the
lowest	possible	values	(that	is,	0-255),	while	the	high-order	byte	contains
the	bits	that	specify	the	large	values	(that	is,	256-65535	in	a	short
integer).

Example:	Intel	Format
The	following	figure	shows	the	Intel	format	for	a	channel	with	Start	Bit=0
and	Number	of	Bits=32.

Example:	Motorola	Format
The	following	figure	shows	the	Motorola	format	for	a	channel	with	Start
Bit=32	and	the	Number	of	Bits=32.



Note		Vector's	CANdb	Editor	supports	Motorola	Forward	and	Motorola	Backward	byte	order.
Motorola	Backward	is	the	same	as	Motorola	Forward,	except	that	the	Start	Bit	counts	from	the
last	bit	of	the	message.	When	you	import	Motorola	Backward	channels	from	a	CANdb	file,	MAX
converts	the	Start	Bit	to	Motorola	Forward	conventions.



Data	Type
Data	Type	defines	how	the	bits	in	the	channel	are	interpreted.	Unsigned
type	can	represent	only	positive	integer	values,	Signed	type	can
represent	positive	and	negative	integers,	and	IEEE	Float	can	represent
any	number	with	7	or	15	significant	decimals	(32	or	64	bit).



Scaling	Factor	and	Offset
You	can	use	Scaling	Factor	and	Offset	to	convert	the	raw	data	in	a
message	to	or	from	scaled	floating-point	units.
You	can	linearly	scale	the	raw	data	in	the	message	by	using	the	formula
y	=	a*x	+	b,	where	a	represents	the	scaling	factor	and	b	the	scaling
offset.	x	is	the	value	the	channel	bits	represent	according	to	the	data
type,	and	y	is	the	resulting	scaled	channel	value.
Scaling	can	change	the	range	of	values	the	Data	Type	represents.



Minimum	and	Maximum	Value
The	Maximum	and	Minimum	values	are	used	to	set	the	range	for	the
floating-point	units	of	the	channels.
The	Channel	API	CAN	Read	and	CAN	Write	functions	do	not	coerce
samples	when	converting	to	or	from	CAN	messages.



Default	Value
Default	Value	configures	the	default	value	of	the	channel	in	scaled
floating-point	units.
In	the	Channel	API	CAN	Read	function,	the	default	value	is	returned	if	no
message	is	received	since	the	start	of	the	application.
In	the	Channel	API	CAN	Write	function,	default	values	are	written	for
channels	not	specified	in	the	task	of	the	Initialize	function.
Refer	to	the	descriptions	of	the	CAN	Read	and	CAN	Write	functions	in
the	NI-CAN	Help	at	Help»Help	Topics»NI-CAN»Hardware	and
Software	Manual	for	further	information.



Unit
Unit	configures	the	channel	unit	string.	The	string	is	no	more	than	64
characters	in	length.	You	can	use	this	value	to	display	units	(such	as
volts	or	RPM)	along	with	the	channel's	samples.



Comment
Comment	contains	any	comment	for	documentation	purposes.	The
maximum	size	of	the	comment	is	1024	characters.



Mode-dependent	Channels
Mode-dependent	channels	are	defined	on	the	mode	item.	They	are	only
valid	when	the	mode	channel	in	the	frame	has	the	value	defined	in	the
mode	properties	dialog	box.	Channels	within	the	mode	must	not	overlap
each	other,	but	it	is	allowed	to	overlap	channels	in	another	mode	of	the
same	multiplexer.	For	more	information	on	mode-dependent	channels,
refer	to	Mode-dependent	Channels	in	MAX.
The	message	overview	in	the	channel	properties	dialog	box	displays
other	channels	coded	by	colors:
Orange:	These	bits	are	used	by	non-dependent	channels	or	channels
defined	in	another	multiplexer.	It	is	not	allowed	to	overlap	them	with	bits
of	the	current	channel.
Green:	These	bits	are	used	by	mode-dependent	channels	in	the	same
multiplexer,	but	with	another	mode	value.	It	is	allowed	to	overlap	those
bits	by	the	current	channel	bits.
Gray:	Other	channels	in	the	same	mode	and	the	mode	channel	defined
in	the	multiplexer	dialog	box	are	displayed	with	bit	numbers.



Changing	Properties	of	Multiple	Messages	or	Channels
This	topic	deals	with	configuring	multiple	messages	or	properties	at	once.
To	configure	each	property	of	a	single	message	individually,	refer	to	the
Message	Properties	Dialog	Box	topic.	To	configure	each	property	of	a
single	channel	individually,	refer	to	the	CAN	Channel	Properties	Dialog
Box	topic.
Right-click	on	CAN	Channels	in	the	MAX	Configuration	tree.
To	change	the	properties	of	multiple	messages,	select	the	All	Messages
tab	at	the	bottom	of	the	right	window.	Specify	messages	by	pressing
<Ctrl>	while	selecting	in	the	right	window,	then	right-click	and	select
Change	Common	Properties.	Select	the	checkbox	next	to	each
property	you	want	to	change,	then	specify	the	new	value	for	all
messages.	Select	OK	to	change	the	selected	properties	for	all	selected
messages.
To	change	the	properties	of	multiple	channels,	select	the	All	Channels
tab	at	the	bottom	of	the	right	window.	Specify	channels	by	pressing
<Ctrl>	while	selecting	in	the	right	window,	then	right-click	and	select
Change	Common	Properties.	Select	the	checkbox	next	to	each
property	that	you	want	to	change,	then	specify	the	new	value	for	all
channels.	Select	OK	to	change	the	selected	properties	for	all	selected
channels.



Test	Panel
With	the	Test	Panel,	you	can	read	or	write	channel	data	for	testing
purposes.
To	start	the	Test	Panel,	right-click	on	a	channel	in	MAX	and	select	Test
Panel	from	the	menu.



Interface
Use	the	Interface	selection	to	determine	which	CAN	interface	to	use	for
read	or	write	of	the	channel.	The	Test	Panel	must	be	stopped	using	the
Stop	button	to	change	the	Interface.
The	USB-847x	CAN	and	LIN	interfaces	do	not	support	direct	reading	and
writing	of	channel	data,	and	are	not	accessible	through	the	Test	Panel.	If
your	CAN	application	requires	channel	access,	refer	to	the	Frame	to
Channel	Conversion	section	of	Chapter	6,	Using	the	Channel	API,	in	the
NI-CAN	Hardware	and	Software	Manual.
Listen	Only
This	checkbox	is	available	only	for	Series	2	hardware	and	only	within	the
Read	tab.	When	checked,	the	interface	receives	frames	in	a	passive
manner	and	does	not	transmit	acknowledgements.



Read	Tab
The	Test	Panel	starts	in	read	mode	using	the	interface	assigned	to	the
message.	The	default	sample	rate	is	1000	Hz.	You	can	change	the
sample	rate	only	after	clicking	on	the	Stop	button	to	stop	the	reading.
Sample	Rate
The	sample	rate	specifies	the	rate	at	which	CAN	data	is	copied	into	the
waveform.	The	value	of	every	sample	is	set	to	the	most	recent	value
received	on	the	channel	for	that	time.

Note		When	no	data	is	received	on	the	channel,	the	Default	Value	specified	in	Channel
Properties	is	displayed	for	the	channel.	At	such	an	event,	the	error	indicator	is	yellow,	indicating
an	old	data	warning	(error	code	0x3FF62009).	This	means	the	new	displayed	data	does	not
contain	any	new	information.

Scaling
You	can	set	the	chart	to	Fixed	Scaling	or	Auto	Scaling	mode.	In	the	Fixed
Scaling	mode,	the	maximum	and	the	minimum	values	set	in	Channel
Properties	are	used.	When	the	user	does	not	change	the	maximum	and
minimum	values,	the	Test	Panel	uses	the	default	range	of	0	to	10.	In	Auto
Scaling	mode,	the	chart	range	is	adjusted	during	run	time	to	display	the
chart	in	the	best	possible	way.
Error	Indicator
The	error	indicator	is	gray	when	no	errors	are	detected.	Yellow	indicates
a	warning.	A	warning	does	not	stop	the	reading	or	writing.	Red	indicates
an	error,	and	the	reading	or	writing	is	stopped.	For	more	details	on	a
warning	or	error,	click	on	the	Details	button	below	the	indicator.



Write	Tab
To	change	to	write	mode,	click	on	the	tab	above	the	chart	display.	This	is
possible	only	when	you	stop	the	reading.	With	the	pointer	slide,	you	can
set	the	value	to	be	written	to	the	channel.	For	Boolean	values	(using	one
bit	in	the	message),	a	switch	is	used	instead	of	a	slide.
For	other	channels	in	the	message,	the	Default	Value	set	in	the	Channel
Properties	dialog	box	is	written.
The	CAN	messages	are	written	at	the	sample	rate	set	on	the	left	side	of
the	panel.	If	a	sample	rate	of	zero	is	selected,	frames	are	transmitted	by
clicking	on	the	Send	button.	This	is	the	default.	For	nonzero	sample
rates,	the	frames	are	transmitted	periodically,	and	the	Send	button
disappears.	If	the	sample	rate	is	too	high—depending	on	the	baud	rate,
message	size,	and	bus	traffic—error	0xBFF62102	is	displayed	indicating
that	a	sample	rate	or	duration	is	too	large	or	too	small.



Duplicate	Message	Dialog	Box
To	duplicate	a	message	in	MAX,	right-click	on	the	message	under	CAN
Channels	and	select	Duplicate.	In	the	dialog	box	you	can	change	the
name,	arbitration	ID,	interface,	and	comment.	The	duplicated	message
contains	all	channels	of	the	original	message.

Note		All	channel	names	in	the	duplicated	message	become	ambiguous.	In	the	Channel	API
Initialize	function,	you	must	specify	the	channel	name	as	<message	name>.<channel	name>	to
avoid	name	conflicts.



Saving	Channels	in	NI-CAN	Database	File
You	can	save	messages	and	channels	defined	in	MAX	to	a	file.	This
option	facilitates	moving	channel	configuration	information	stored	in	a	file
to	another	computer.	The	files	are	always	saved	with	a	.ncd	(NI-CAN
Channel	Definition)	extension.
To	save	all	messages	and	channels	from	MAX	to	a	file,	right-click	on
CAN	Channels	in	the	MAX	Configuration	tree	and	select	Save	Channel
Configuration.
To	save	selected	messages	from	MAX	to	a	file,	right-click	on	CAN
Channels	in	the	MAX	Configuration	tree	and	select	the	All	Messages
tab	at	the	bottom	of	the	right	window.	Specify	messages	by	pressing
<Ctrl>	while	selecting	in	the	right	window,	then	right-click	and	select	Save
Selected	Messages.



Loading	Channels	from	NI-CAN	Database	File
To	load	channels	previously	saved	to	a	NI-CAN	database	file	(.ncd),	right-
click	on	CAN	Channels	in	Data	Neighborhood	and	select	Load
Channel	Configuration.	The	operation	starts	with	an	Open	File	dialog
box.	After	selecting	a	file	and	clicking	on	the	Open	button,	the	messages
contained	in	the	file	are	displayed	alphabetically	sorted	in	the	list	box.
For	performance	reasons,	you	should	load	only	messages	required	for
the	application	into	MAX.	To	select	a	message	in	the	list,	click	on	the
message	name.	Channels	contained	in	the	message	are	displayed	on
the	right	side.	Clicking	on	the	Load	button	copies	the	message	and
associated	channels	into	MAX.	The	dialog	box	remains	open	until	you
click	on	Done,	so	you	can	select	and	load	multiple	groups	of	messages.



Selecting	Multiple	Messages
Left-click	on	the	first	message,	hold	down	the	mouse	button,	and	move
the	cursor	up	or	down	to	select	several	messages.
To	select	messages	individually,	hold	down	<Ctrl>	and	click	on	the
messages.



Loading	All	Messages	from	the	File
To	load	all	messages,	select	Add	all	Messages	and	Channels.



Message	Name	Prefix
MAX	does	not	allow	defining	two	messages	with	the	same	name.	If	the
selection	contains	messages	with	names	already	defined	in	MAX,	a
dialog	box	appears	to	resolve	name	conflicts	before	the	messages	are
copied	to	MAX.	To	resolve	name	conflicts,	prepend	a	prefix	to	all
imported	messages.	After	entering	the	prefix,	the	user	can	click	on	the
Check	button	to	verify	whether	the	name	conflict	has	been	resolved.	The
prefix	is	added	to	all	imported	messages,	not	only	the	message	that
caused	name	conflicts.
If	the	name	conflicts	are	not	resolved	when	you	click	on	the	OK	button,
the	existing	messages	with	the	same	name	are	overwritten.	The	user	is
asked	to	overwrite	every	message	or,	by	clicking	on	Yes	to	All,	to	allow
all	following	messages	to	be	overwritten	without	further	questions.



Loading	another	NI-CAN	Database	File
By	clicking	on	the	[...]	button,	you	can	load	another	.ncd	file	into	the
dialog	box	to	load	messages	and	channels	from	it	without	leaving	the
dialog	box.



Importing	from	CANdb	File
MAX	can	import	messages	and	channels	from	a	CANdb	(.dbc)	file.	Right-
click	on	CAN	Channels	in	Data	Neighborhood	and	select	Import	from
CANdb	File.	The	operation	starts	with	an	Open	File	dialog	box.	After
selecting	a	file	and	clicking	on	the	Open	button,	the	messages	contained
in	the	file	are	displayed	alphabetically	sorted	in	the	list	box.
For	performance	reasons,	you	should	import	only	messages	required	for
the	application	into	MAX.	To	select	a	message	in	the	list,	click	on	the
message	name.	Channels	contained	in	the	message	are	displayed	on
the	right	side.	Selecting	Import	copies	the	message	and	associated
channels	into	MAX.	The	dialog	box	remains	open	until	you	click	on	Done,
so	you	can	select	and	import	multiple	groups	of	messages.



Selecting	Multiple	Messages
Left-click	the	first	message,	hold	down	the	mouse	button,	and	move	the
cursor	up	or	down	to	select	several	messages.
To	select	messages	individually,	hold	down	<Ctrl>	and	click	on	the
messages.



Importing	All	Messages	from	the	File
To	import	all	messages,	select	Add	all	Messages	and	Channels.



Message	Name	Prefix
MAX	does	not	allow	defining	two	messages	with	the	same	name.	If	the
selection	contains	messages	with	names	already	defined	in	MAX,	a
dialog	box	appears	to	resolve	name	conflicts	before	the	messages	are
copied	into	MAX.	Name	conflicts	are	resolved	by	prepending	a	prefix	to
all	imported	messages.	After	entering	the	prefix,	click	on	the	Check
button	to	check	if	the	conflict	has	been	resolved.	The	prefix	is	added	to	all
imported	messages,	not	only	to	the	message	that	caused	name	conflicts.
If	the	name	conflicts	are	not	resolved	when	you	click	on	the	OK	button,
the	existing	messages	are	overwritten.	The	user	is	asked	to	overwrite
every	message	or,	by	clicking	on	Yes	to	All,	to	allow	all	following
messages	to	be	overwritten	without	further	questions.



Importing	another	CANdb	File
By	pressing	the	[...]	button,	you	can	load	another	CANdb	file	into	the
dialog	box	to	import	messages	and	channels	from	it	without	leaving	the
dialog	box.



Deleting	Messages	or	Channels
To	delete	all	messages	and	channels	from	MAX,	right-click	on	CAN
Channels	in	the	MAX	Configuration	tree	and	select	Delete	All
Channels.
To	delete	a	single	message	or	channel,	right-click	on	the	message	or
channel	and	select	Delete.
To	delete	multiple	messages,	right-click	on	CAN	Channels	in	the	MAX
Configuration	tree.	Select	the	All	Messages	tab	at	the	bottom	of	the	right
window.	Specify	messages	by	pressing	<Ctrl>	while	selecting	in	the	right
window,	then	right-click	and	select	Delete	Selected	Messages.
To	delete	multiple	channels,	right-click	on	CAN	Channels	in	the	MAX
Configuration	tree.	Select	the	All	Channels	tab	at	the	bottom	of	the	right
window.	Specify	channels	by	pressing	<Ctrl>	while	selecting	in	the	right
window,	then	right-click	and	select	Delete	Selected	Channels.



Mode-Dependent	Channels	in	MAX
Mode-dependent	channels	allow	a	portion	of	a	message	to	be	used	for
different	information.	The	information	contained	in	the	portion	of	the
message	depends	on	a	mode	channel	value.	Channels	valid	only	on
certain	mode	value	are	called	mode-dependent	channels.
For	example,	Byte	0	in	the	5	byte	message	is	the	mode	channel.	When
byte	0	contains	the	value	0,	byte	1	and	2	contain	a	16	bit	intel	signed
value	representing	velocity.	When	byte	0	contains	the	value	1,	byte	0	is
an	8	bit	unsigned	value	representing	temperature	and	byte	2	is	an	8	bit
signed	value	representing	pressure.	Bytes	3	and	4	of	the	message
contain	time	information	and	are	not	mode	dependent.

To	create	mode-dependent	channels	in	MAX,	complete	the	following
instructions.

1.	 Right-click	on	a	message	and	create	a	multiplexer.
2.	 Define	the	properties	of	the	mode	channel	in	the	Multiplexer

Properties	dialog.	Click	OK	when	you're	finished.
3.	 Right-click	the	multiplexer	item	that	appears	in	the	Configuration

tree	and	select	Create	Mode	to	define	the	value	of	the	mode
channel	(mode	value).

4.	 Right-click	a	mode	item	that	was	created	in	the	configuration	tree
and	select	Create	Channel	to	create	the	channels	that	are	only
valid	when	the	mode-channel	contains	the	specified	mode	value.

The	channels	of	different	modes	in	the	same	multiplexer	may	overlap
each	other.	The	new	mode-dependent	channels	should	appear	as
objects	in	the	MAX	configuration	tree,	similar	to	the	new	channels	in	the
image	below.





Multiplexer	Dialog	Box
A	multiplexer	defines	an	area	within	the	message	which	can	contain
different	information	(channels)	depending	on	the	value	of	the	mode
channel	(mode	value).	The	mode	channel	must	not	overlap	other
channels	within	the	multiplexer	or	channels	outside	of	the	multiplexer.
The	mode	channel	is	defined	within	the	multiplexer	dialog	box.	Mode-
dependent	channels	within	the	multiplexer	are	defined	by	creating	mode
items	on	the	multiplexer	item	and	channel	items	on	the	mode	item.	The
area	within	the	message	controlled	by	the	multiplexer	is	defined	by	all
mode-dependent	channels.
The	Message	Overview	window	in	the	Multiplexer	Properties	dialog	box
displays	channel	bits	coded	by	colors:

The	mode	channel	is	displayed	with	highlighted	numbered	bits.
Mode-dependent	channels	already	defined	within	this	multiplexer
are	green.	They	are	not	numbered	because	one	bit	can	be	used	by
multiple	channels.
Channels	outside	of	the	multiplexer	are	orange.	They	are	not
numbered	for	the	same	reason.

A	message	can	contain	more	than	one	multiplexer.	Every	multiplexer
defines	its	own	area	in	the	message.	A	mode-dependent	channel
depends	always	on	the	value	of	one	mode	channel.



Mode	Dialog	Box
The	mode	item	is	created	on	the	multiplexer	item.	It	defines	the	value	of
the	mode	channel.	All	channels	defined	within	the	mode	are	only	valid
when	the	mode	channel	defined	in	the	multiplexer	has	the	value	defined
in	the	mode	properties	dialog	box.
The	graphical	message	overview	shows	all	channels	with	the	mode	value
as	numbered	bits.	Channels	with	another	mode	value	in	the	same
multiplexer	are	green	and	are	not	numbered.	Channels	outside	of	the
multiplexer	are	not	visible	in	this	overview.



Protocol	Dialog	Box
National	Instruments	hardware	for	Controller	Area	Network	(CAN)	is	used
by	both	NI-CAN	and	NI-DNET	(DeviceNet)	software.
You	can	view	each	CAN	card	in	MAX	with	either	DeviceNet	or	CAN
features.	To	change	the	view	of	a	CAN	card	in	MAX,	right-click	the	card
and	select	Protocol.	In	this	dialog,	you	can	select	either	DeviceNet	for
NI-DNET,	or	CAN	for	NI-CAN.
Use	of	NI-DNET	is	restricted	to	port	1	(top	port)	of	Series	1	CAN	cards.
The	Protocol	selection	is	not	available	for	Series	2	CAN	cards.	When	a
2-port	Series	1	CAN	card	is	selected	as	the	DeviceNet	protocol,	only	the
top	port	is	enabled.	For	more	information	on	hardware	in	CAN	kits	and
DeviceNet	kits,	refer	to	Chapter	2,	DeviceNet	Hardware	Overview,	in	the
NI-DNET	User	Manual.
To	develop	applications	for	the	NI-CAN	or	NI-DNET	Application
Programming	Interface	(API),	you	must	install	API	components	such	as
documentation	and	examples.	The	software	components	for	both	APIs
are	available	within	either	the	NI-CAN	or	NI-DNET	installer.	Launch	the
setup.exe	program	for	the	installer	in	the	same	manner	as	your	original
installation	(CD	or	ni.com	download).	Within	the	installer,	select	both	NI-
DNET	and	NI-CAN	components	in	the	feature	tree.
When	you	right-click	a	port	in	MAX	and	select	Properties,	the	resulting
Interface	selection	uses	the	syntax	CANx	or	DNETx	based	on	your
protocol	selection.	Regardless	of	which	protocol	is	selected,	the	number
x	is	the	only	relevant	identifier	with	respect	to	NI-CAN	and	NI-DNET
functions.	For	example,	if	you	select	DNET0	as	an	interface	in	MAX,	you
can	run	an	NI-DNET	application	that	uses	DNET0,	then	you	can	run	an
NI-CAN	application	that	uses	CAN0.	Both	applications	refer	to	the	same
port	and	can	run	at	different	times,	but	not	simultaneously.



MAX	Report	Generation
Use	the	MAX	Report	Wizard	to	generate	a	report	of	the	NI-CAN
hardware	and	software	configuration	of	the	local	system.	The	report
includes	the	following	information.

List	of	properties	for	an	NI-CAN	interface:
Protocol
Serial	Number
Series

List	of	properties	for	an	NI-CAN	port:
Interface	name
Location
Transceiver	Type	(if	driver	is	able	to	determine	it)
Transceiver	Name	(if	driver	is	able	to	determine	it)
Baud	Rate
Sample	Point
BTR	Settings

CAN	channel	tables
Tables	in	"NI-CAN	Channels"	contain	all	properties	which
can	be	configured	in	MAX/Data	Neighborhood/CAN
Channels.

By	default,	the	MAX	Report	Wizard	will	include	any	CAN	channels	listed
in	MAX.	To	reduce	the	MAX	report	file	size,	deselect	this	option	when
configuring	the	MAX	report.

Note		When	printing	out	the	MAX	report	file,	depending	on	paper	format	and	internet	browser,
the	tables	can	exceed	the	size	of	the	paper	so	information	may	be	missing	in	the	printed
documentation.

mxHelp.chm::/maxmain/reportgen.html


Important	Information
Warranty
Copyright
Trademarks
Patents
Warning	Regarding	Use	of	NI	Products



Warranty
National	Instruments	CAN	and	DeviceNet	hardware	is
warranted	against	defects	in	materials	and	workmanship	for	a
period	of	one	year	from	the	date	of	shipment,	as	evidenced	by
receipts	or	other	documentation.	National	Instruments	will,	at	its
option,	repair	or	replace	equipment	that	proves	to	be	defective
during	the	warranty	period.	This	warranty	includes	parts	and
labor.
The	media	on	which	you	receive	National	Instruments	software
are	warranted	not	to	fail	to	execute	programming	instructions,
due	to	defects	in	materials	and	workmanship,	for	a	period	of	90
days	from	date	of	shipment,	as	evidenced	by	receipts	or	other
documentation.	National	Instruments	will,	at	its	option,	repair	or
replace	software	media	that	do	not	execute	programming
instructions	if	National	Instruments	receives	notice	of	such
defects	during	the	warranty	period.	National	Instruments	does
not	warrant	that	the	operation	of	the	software	shall	be
uninterrupted	or	error	free.
A	Return	Material	Authorization	(RMA)	number	must	be
obtained	from	the	factory	and	clearly	marked	on	the	outside	of
the	package	before	any	equipment	will	be	accepted	for
warranty	work.	National	Instruments	will	pay	the	shipping	costs
of	returning	to	the	owner	parts	which	are	covered	by	warranty.
National	Instruments	believes	that	the	information	in	this
document	is	accurate.	The	document	has	been	carefully
reviewed	for	technical	accuracy.	In	the	event	that	technical	or
typographical	errors	exist,	National	Instruments	reserves	the
right	to	make	changes	to	subsequent	editions	of	this	document
without	prior	notice	to	holders	of	this	edition.	The	reader	should
consult	National	Instruments	if	errors	are	suspected.	In	no
event	shall	National	Instruments	be	liable	for	any	damages



arising	out	of	or	related	to	this	document	or	the	information
contained	in	it.
EXCEPT	AS	SPECIFIED	HEREIN,	NATIONAL	INSTRUMENTS
MAKES	NO	WARRANTIES,	EXPRESS	OR	IMPLIED,	AND
SPECIFICALLY	DISCLAIMS	ANY	WARRANTY	OF
MERCHANTABILITY	OR	FITNESS	FOR	A	PARTICULAR
PURPOSE.	CUSTOMER'S	RIGHT	TO	RECOVER	DAMAGES
CAUSED	BY	FAULT	OR	NEGLIGENCE	ON	THE	PART	OF
NATIONAL	INSTRUMENTS	SHALL	BE	LIMITED	TO	THE
AMOUNT	THERETOFORE	PAID	BY	THE	CUSTOMER.
NATIONAL	INSTRUMENTS	WILL	NOT	BE	LIABLE	FOR
DAMAGES	RESULTING	FROM	LOSS	OF	DATA,	PROFITS,
USE	OF	PRODUCTS,	OR	INCIDENTAL	OR
CONSEQUENTIAL	DAMAGES,	EVEN	IF	ADVISED	OF	THE
POSSIBILITY	THEREOF.	This	limitation	of	the	liability	of
National	Instruments	will	apply	regardless	of	the	form	of	action,
whether	in	contract	or	tort,	including	negligence.	Any	action
against	National	Instruments	must	be	brought	within	one	year
after	the	cause	of	action	accrues.	National	Instruments	shall	not
be	liable	for	any	delay	in	performance	due	to	causes	beyond	its
reasonable	control.	The	warranty	provided	herein	does	not
cover	damages,	defects,	malfunctions,	or	service	failures
caused	by	owner's	failure	to	follow	the	National	Instruments
installation,	operation,	or	maintenance	instructions;	owner's
modification	of	the	product;	owner's	abuse,	misuse,	or	negligent
acts;	and	power	failure	or	surges,	fire,	flood,	accident,	actions
of	third	parties,	or	other	events	outside	reasonable	control.



Copyright
Under	the	copyright	laws,	this	publication	may	not	be
reproduced	or	transmitted	in	any	form,	electronic	or
mechanical,	including	photocopying,	recording,	storing	in	an
information	retrieval	system,	or	translating,	in	whole	or	in	part,
without	the	prior	written	consent	of	National	Instruments
Corporation.
National	Instruments	respects	the	intellectual	property	of
others,	and	we	ask	our	users	to	do	the	same.	NI	software	is
protected	by	copyright	and	other	intellectual	property	laws.
Where	NI	software	may	be	used	to	reproduce	software	or	other
materials	belonging	to	others,	you	may	use	NI	software	only	to
reproduce	materials	that	you	may	reproduce	in	accordance	with
the	terms	of	any	applicable	license	or	other	legal	restriction.



Trademarks
National	Instruments,	NI,	ni.com,	and	LabVIEW	are	trademarks
of	National	Instruments	Corporation.	Refer	to	the	Terms	of	Use
section	on	ni.com/legal	for	more	information	about	National
Instruments	trademarks.
FireWire®	is	the	registered	trademark	of	Apple	Computer,	Inc.
Handle	Graphics®,	MATLAB®,	Real-Time	Workshop®,
Simulink®,	Stateflow®,	and	xPC	TargetBox®	are	registered
trademarks,	and	TargetBox™	and	Target	Language	Compiler™
are	trademarks	of	The	MathWorks,	Inc.
LIN	is	a	registered	Trademark	®.	Refer	to	the	LIN	Consortium
for	more	information.
Tektronix®	and	Tek	are	registered	trademarks	of	Tektronix,	Inc.
Other	product	and	company	names	mentioned	herein	are
trademarks	or	trade	names	of	their	respective	companies.
Members	of	the	National	Instruments	Alliance	Partner	Program
are	business	entities	independent	from	National	Instruments
and	have	no	agency,	partnership,	or	joint-venture	relationship
with	National	Instruments.

javascript:WWW(WWW_Trademark)


Patents
For	patents	covering	National	Instruments	products,	refer	to	the
appropriate	location:	Help»Patents	in	your	software,	the
patents.txt	file	on	your	CD,	or	ni.com/patents.

javascript:WWW(WWW_Patents)


WARNING	REGARDING	USE	OF	NATIONAL
INSTRUMENTS	PRODUCTS
(1)	NATIONAL	INSTRUMENTS	PRODUCTS	ARE	NOT
DESIGNED	WITH	COMPONENTS	AND	TESTING	FOR	A
LEVEL	OF	RELIABILITY	SUITABLE	FOR	USE	IN	OR	IN
CONNECTION	WITH	SURGICAL	IMPLANTS	OR	AS
CRITICAL	COMPONENTS	IN	ANY	LIFE	SUPPORT	SYSTEMS
WHOSE	FAILURE	TO	PERFORM	CAN	REASONABLY	BE
EXPECTED	TO	CAUSE	SIGNIFICANT	INJURY	TO	A	HUMAN.
(2)	IN	ANY	APPLICATION,	INCLUDING	THE	ABOVE,
RELIABILITY	OF	OPERATION	OF	THE	SOFTWARE
PRODUCTS	CAN	BE	IMPAIRED	BY	ADVERSE	FACTORS,
INCLUDING	BUT	NOT	LIMITED	TO	FLUCTUATIONS	IN
ELECTRICAL	POWER	SUPPLY,	COMPUTER	HARDWARE
MALFUNCTIONS,	COMPUTER	OPERATING	SYSTEM
SOFTWARE	FITNESS,	FITNESS	OF	COMPILERS	AND
DEVELOPMENT	SOFTWARE	USED	TO	DEVELOP	AN
APPLICATION,	INSTALLATION	ERRORS,	SOFTWARE	AND
HARDWARE	COMPATIBILITY	PROBLEMS,	MALFUNCTIONS
OR	FAILURES	OF	ELECTRONIC	MONITORING	OR
CONTROL	DEVICES,	TRANSIENT	FAILURES	OF
ELECTRONIC	SYSTEMS	(HARDWARE	AND/OR
SOFTWARE),	UNANTICIPATED	USES	OR	MISUSES,	OR
ERRORS	ON	THE	PART	OF	THE	USER	OR	APPLICATIONS
DESIGNER	(ADVERSE	FACTORS	SUCH	AS	THESE	ARE
HEREAFTER	COLLECTIVELY	TERMED	"SYSTEM
FAILURES").	ANY	APPLICATION	WHERE	A	SYSTEM
FAILURE	WOULD	CREATE	A	RISK	OF	HARM	TO	PROPERTY
OR	PERSONS	(INCLUDING	THE	RISK	OF	BODILY	INJURY
AND	DEATH)	SHOULD	NOT	BE	RELIANT	SOLELY	UPON
ONE	FORM	OF	ELECTRONIC	SYSTEM	DUE	TO	THE	RISK
OF	SYSTEM	FAILURE.	TO	AVOID	DAMAGE,	INJURY,	OR



DEATH,	THE	USER	OR	APPLICATION	DESIGNER	MUST
TAKE	REASONABLY	PRUDENT	STEPS	TO	PROTECT
AGAINST	SYSTEM	FAILURES,	INCLUDING	BUT	NOT
LIMITED	TO	BACK-UP	OR	SHUT	DOWN	MECHANISMS.
BECAUSE	EACH	END-USER	SYSTEM	IS	CUSTOMIZED	AND
DIFFERS	FROM	NATIONAL	INSTRUMENTS'	TESTING
PLATFORMS	AND	BECAUSE	A	USER	OR	APPLICATION
DESIGNER	MAY	USE	NATIONAL	INSTRUMENTS
PRODUCTS	IN	COMBINATION	WITH	OTHER	PRODUCTS	IN
A	MANNER	NOT	EVALUATED	OR	CONTEMPLATED	BY
NATIONAL	INSTRUMENTS,	THE	USER	OR	APPLICATION
DESIGNER	IS	ULTIMATELY	RESPONSIBLE	FOR	VERIFYING
AND	VALIDATING	THE	SUITABILITY	OF	NATIONAL
INSTRUMENTS	PRODUCTS	WHENEVER	NATIONAL
INSTRUMENTS	PRODUCTS	ARE	INCORPORATED	IN	A
SYSTEM	OR	APPLICATION,	INCLUDING,	WITHOUT
LIMITATION,	THE	APPROPRIATE	DESIGN,	PROCESS	AND
SAFETY	LEVEL	OF	SUCH	SYSTEM	OR	APPLICATION.



Technical	Support	and	Professional	Services
Visit	the	following	sections	of	the	National	Instruments	Web	site
at	ni.com	for	technical	support	and	professional	services:

Support—Online	technical	support	resources	at
ni.com/support	include	the	following:

Self-Help	Resources—For	answers	and	solutions,
visit	the	award-winning	National	Instruments	Web
site	for	software	drivers	and	updates,	a	searchable
KnowledgeBase,	product	manuals,	step-by-step
troubleshooting	wizards,	thousands	of	example
programs,	tutorials,	application	notes,	instrument
drivers,	and	so	on.
Free	Technical	Support—All	registered	users
receive	free	Basic	Service,	which	includes	access	to
hundreds	of	Applications	Engineers	worldwide	in	the
NI	Discussion	Forums	at	ni.com/forums.	National
Instruments	Applications	Engineers	make	sure	every
question	receives	an	answer.
For	information	about	other	technical	support	options
in	your	area,	visit	ni.com/services	or	contact	your	local
office	at	ni.com/contact.

Training	and	Certification—Visit	ni.com/training	for	self-
paced	training,	eLearning	virtual	classrooms,	interactive
CDs,	and	Certification	program	information.	You	also	can
register	for	instructor-led,	hands-on	courses	at	locations
around	the	world.
System	Integration—If	you	have	time	constraints,	limited
in-house	technical	resources,	or	other	project	challenges,
National	Instruments	Alliance	Partner	members	can	help.
To	learn	more,	call	your	local	NI	office	or	visit
ni.com/alliance.
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If	you	searched	ni.com	and	could	not	find	the	answers	you
need,	contact	your	local	office	or	NI	corporate	headquarters.
You	also	can	visit	the	Worldwide	Offices	section	of
ni.com/niglobal	to	access	the	branch	office	Web	sites,	which
provide	up-to-date	contact	information,	support	phone	numbers,
email	addresses,	and	current	events.
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Branch	Offices
Office Telephone	Number
Australia 1800	300	800
Austria 43	0	662	45	79	90	0
Belgium 32	0	2	757	00	20
Brazil 55	11	3262	3599
Canada 800	433	3488
China 86	21	6555	7838
Czech	Republic 420	224	235	774
Denmark 45	45	76	26	00
Finland 385	0	9	725	725	11
France 33	0	1	48	14	24	24
Germany 49	0	89	741	31	30
India 91	80	41190000
Israel 972	0	3	6393737
Italy 39	02	413091
Japan 81	3	5472	2970
Korea 82	02	3451	3400
Lebanon 961	0	1	33	28	28
Malaysia 1800	887710
Mexico 01	800	010	0793
Netherlands 31	0	348	433	466
New	Zealand 0800	553	322
Norway 47	0	66	90	76	60
Poland 48	22	3390150
Portugal 351	210	311	210



Russia 7	495	783	68	51
Singapore 1800	226	5886
Slovenia 386	3	425	42	00
South	Africa 27	0	11	805	8197
Spain 34	91	640	0085
Sweden 46	0	8	587	895	00
Switzerland 41	56	200	51	51
Taiwan 886	02	2377	2222
Thailand 662	278	6777
Turkey 90	212	279	3031
United	Kingdom 44	0	1635	523545
United	States	(Corporate) 512	683	0100
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